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Introduction 
 

IGX Overview 
The IGX Portal specializes in improving functionality and ease of use.  These are the areas that the IGX Portal shines in: 
 

• IGX Dashboard – The IGX Dashboard allows users to register for portal.  It also allows users to initiate, complete, and 
submit applications. 

 

• Easy Configuration of Program Changes – The IGX portal takes advantage of a new drag-and-drop configuration 
engine to allow users to make changes to their programs.  This includes easily updating forms, process flows, and 
management reports. 

 

• Updated Accessibility Features – IGX was built from the ground up to adhere to ADA and WCAG 2.1 AA standards.  
The portal will also undergo regular 3rd party web accessibility compliance audits.  It includes new options like a high 
contrast mode and new branding utilities, making it easier to accommodate individuals with disabilities. 

 

Current IGX Contact Information 
IGX has supplied the following contact information for users:  
 

Agency/Individual Name Phone Number Email Address Website URL 

Agate Software Helpdesk 1 (800) 820-1890 helpdesk@agatesoftware.com  
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System Requirements 
 
The system was designed so that computer users can use it with little or no changes to their computer environment. The 
requirements that are mentioned below are common computer elements that should be already present. 
 

Internet Connection 
The grants management system is an internet application designed for and accessed via the internet.  
 

Internet Access 
This system was designed to be compatible with common up-to-date web browsers such as Microsoft Edge, Chrome, 
Firefox, or Safari.  If the web browser is not update, the following message will display: 
 

 
 

Enabling Cookies 
The web browser must enable cookies for this site in order to access this portal. 
 

Multiple Browser Windows 
Do not open multiple windows or browser tabs while filling out the document, as this can cause issues with browser 
cookies resulting in either being kicked out of the system or work being lost. 
NOTE: If the user needs to have multiple windows open please ensure that the user is using a separate browser 
session instead.  
 
If utilizing Microsoft Edge, click on File → New Session for each browser session. Other internet browsers will require 
third party add-ons to manage multiple browser sessions. 
 

Adobe Acrobat DC 
Adobe Acrobat DC (Adobe Acrobat Reader) is used to view PDF (Portable Document Format) documents. The system will 
automatically generate grant documents in PDF format using information that has been saved into the various narrative 
and budget pages. Using Adobe Acrobat DC, the user may choose to view, print, or save these documents.  Users who 
do not have this software installed on their systems will need to download it from www.adobe.com. 
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System Login Page 
 

URL 
To access the IGX portal, type the following into the address bar of the web browser and press Enter.  
https://kohs.intelligrants.com/ 
 
NOTE: The IGX portal does not save the username and password. This option may be available for some browsers. 
 

IGX Portal Home Login Page Sections 
 

 
 
The IGX portal login page is organized into Welcome/Announcements and Login sections. 
 

Welcome/Announcements! 
This is the section where are welcomed to the portal and allowed to view posted announcements.  These 
announcements may include links. 
 

IGX Portal Login Section 
The IGX portal login process requires a user to enter in a Username and Password to login. 
NOTE: The password field is case sensitive and will not recognize characters of the wrong case. Precision when 
entering the username into the username field will decrease the risk of system error messages. 
 

Logging in to the IGX Portal 

Username 
The username is created by the new user during the registration process OR by the user adding this user to the 
organization. 
 

Password 
The password is created automatically by the portal once a new user is added. 
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Submit Button 
Push the Submit Button to login onto the IGX Portal. 
 

Trouble Shooting Issues IGX Portal Login Issues 

Forgot Username 
The IGX portal allows the user to request the retrieval of their username. To do so, complete the following steps: 

1) Click on the Forgot Username/Password! link. 
 

 
 

2) Click on the Forgot Username link.  
 

 
 

3) Enter the email address and click the EMAIL button to request the username.  
4) The user can follow the instructions in the “Forgot Password” section to allow them to log into the system. 

 

“Locked Out” 
A user is “locked out” when they have exceeded a specific number of attempts to login. The user may use the Forgot 
Password link to request a temporary password at any point using the “Forgot Password” link instructions (below). 
 

Forgot Password 
The IGX portal allows users to request a temporary password by email. To do so, complete the following steps: 

1) Click on the Forgot Username/Password! link. 
2) Enter the username and the email address. Click the EMAIL button. A temporary password will be sent to the 

email address supplied. 
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3) Once the user has received a temporary password, they will need to login.  

NOTE: The password field is case sensitive and will not recognize characters of the wrong case. Precision when 
entering the username into the username field will decrease the risk of system error messages. 
 

4) At that point, the user will be brought directly to the Profile page and requested to create a new password. The 
user can use the Edit Password button at the bottom of the page to update the password.  When the user clicks 
on the Edit Password button, the Password and Confirm Password fields are available. 

 

 
 

New User 
The IGX portal allows the user to request access to the system. To do so, complete the following steps: 

1) Click on the New User? Click Here link. 
 

 
 

2) Fill in the required fields (*) and any optional fields desired and click on the Save button. 
NOTE: Users registering by the New User link will need to be approved by pre-existing IGX portal users. 

 
NOTE: If a user attempts to access the system before they have been approved, the system will show their 
password as invalid. 
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Legend 
First Name (Required) – the first name of the registering user. 
Middle Name – the middle name of the registering user. 
Last Name (Required) – the last name of the registering user. 
Organization (Required) – the name of the organization the registering user wants to register under. 
Title – the position title of the registering user. 
Address (Required) – the street address of the organization the user is registering for. 
Address 2 – a second street address for the organization that the user is registering for. 
State (Required) – the state drop-down selection for the state of the registering user’s organization. 
County (Required) – the county drop-down selection for the county of the registering user’s organization. 
City (Required) – the name of the city of the registering user’s organization. 
Zip Code (Required) – the zip of the registering user’s organization. 
Email (Required) – the email address of the registering user. 
Phone (Required) – the phone number of the registering user. 
Username (Required) – the username the registering user wishes to register for.   
Password/Verify Password (Required) – the password the registering user wishes to register for. 
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User Information 
 

Profile 
Once a person logs into the system, their Profile page and a list of organizations the individual belongs to is visible. 
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Basic Information Legend 
First Name – the first name of the individual. 
Middle Name – the middle name of the individual. 
Last Name – the last name of the individual. 
Prefix – an optional prefix for the individual. 
Suffix – an optional suffix for the individual. 
Title – the position title for the individual. 
Telephone # – the primary phone number for the individual. 
Cell # – the optional cell phone number for the individual. 
Email – the email address of the individual. 
 
Address Information Legend 
Street Address – the street address for the individual. 
Address2 – a secondary street address for the individual. 
State – the dropdown menu of the state the individual’s street address is in. 
County – the dropdown menu of the county the individual’s street address is in. 
City – the city the individual’s street address is in. 
Zip – the zip code the individual’s street address is in. 
 
Additional Information Legend 
Job Certification – a repository for uploading personal certification forms. 
Security Image – an optional security image to implement as an additional security measure. 
Username – a label containing the individual’s username and a button to allow the individual to update the username. 
Password – a label containing the individual’s current password and a button to update the password. 
 

Organizations 
This section contains a table with the label for the role the individual has in that organization, the active date field, the 
inactive date field, and the name of the person who assigned that individual to the organization.  
NOTE: A person can have multiple organizations listed. 
 

  



KOHS - IGX – Administration & Registration Manual 
 

1/28/21 Copyright © Agate Software, Inc.  Page 12 of 28 

 

Messaging 
Under the Profile section, there is a messaging section where the user can create messages. 
 

Inbox 
To access the inbox, please follow these instructions: 

1) Click on the Name link at the top of the page on the right side.  In this example, it is labeled “IA Testing”. 
2) Click on the Messages link in the right-hand column. 

 

 
 

3) This brings up the Inbox.  Email searches are completed in the Inbox Search section.  Emails can be marked as 
read by checking one (or more than one) of the checkbox(s), selecting the “Mark as Read” setting from the drop-
down list, and clicking the APPLY button. 
NOTE: The user can click on the Inbox link on the left-hand side to access this page. 

 
4) Click on the row of a specific email to access it. 
 

Sent 
A user can access previously sent emails by following these instructions: 
 

1) Click on the Name link at the top of the page on the right side.  In this example, it is labeled “IA Testing”. 
2) Click on the Messages link in the right-hand column. 
3) Click on the Sent link in the left-hand column. 
4) This brings up past emails.  Click on the row of a specific email to open it up for review.  
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Home 
 
The Home page is the home page for IGX portal users. From here, the rest of the system can be navigated.  
 

 
 

Tabs 
Home 
This is a navigation link that will return the user to the Home page from anywhere in the system. 
 

Administration 
This is a navigation link that will allow the user to complete some organization functions.  The user can access this link 
from anywhere in the system. 
 

Searches 
This is a navigation link that will allow the user to conduct document searches for that organization.  The user can access 
this link from anywhere in the system.  
 

Menu Options 
• Grant Applications 

• Reimbursement Claims 

• Monitoring Reports 

• Assistant Requests 
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Icons 
 

   

 

Theme 
Setting 

This button switches the theme visible from black and white to color and vice versa. 

   

   

 
Help Clicking this button allows general help tips to display about the current item selected. 

   

   

Name 

Clicking on the user’s name allows the user to access the Profile, Messages, Edit 
Dashboard, and Logout links. 
 

   

 

Dashboard 
My Tasks 
The My Tasks area is an area that defines the tasks assigned to the user.  It also gives the user a way to initiate a related 
document (like a report or requisition).  This area can be filtered using the Filter function. 
 

 
 

Using the My Tasks Filter 
To use the My Tasks Filter to on a list of tasks assigned to the user, please follow these instructions: 

1. Click on the > sign next to the Filter header. 
2. Enter data into any of the fields and/or select an option from the Type drop-down. 
3. Click the SEARCH button.  This will bring up a list of documents in the My Tasks section. 
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Announcements 
The Announcements area is an area that allows the user access to announcements from the portal designers.  These 
announcements can include (but are not limited to) training dates, news updates, or web site links. 
 

 
 

My Opportunities 
The My Opportunities area allows the user to start grant opportunity documents (usually applications). 
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Grant Opportunities 
Starting a Grant Opportunity 
To start a grant opportunity, please follow these instructions: 

1) Login to the portal in a role that can start applications. 
2) Click on the grant opportunity name in the Name column to bring up a menu with more application information.   
3) Click on the AGREE button to start the application. 

 

 
 

Working on a Grant Opportunity 
Start the grant opportunity using the instructions in the previous section.   

NOTE: The default page for the application is the Document Landing Page. 
 

The Document Landing Page 
The Document Landing Page contains several sections and the New Note button.   

 

 
 

Application Link 
The number listed above the Forms header is the application number.  It also functions as a link to bring the user back to 
the Document Landing Page. 
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Forms Menu 
The Forms Menu is divided into sections containing individual forms for the user(s) to fill in.  There are drop-down 
arrows next to the Forms header that allow the forms to be hidden and other sections uncovered.   
 

 
 

Legend 
Forms – the list of forms.  Usually forms without sections are listed first, then the form list is broken into sections. 
Tools – a list of tools available to the user. 
Status Options – a list of possible status options to apply to the application. This list will vary from user to user, 
depending on which role the user is logged in as and current status of the application. 
 
Related Documents – a list of related documents (primarily reports) associated with the application. 
 

Document Details 
The Document Details section provides visual data including the grant opportunity status, future statuses, the name of 
the organization, the role of the user currently logged in, and both the Period Date and Due Date. 
 

New Note Button 
The New Note button allows a user to leave a note for other users. 
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Grant Opportunity Forms 
Forms 
The list of forms is usually divided into sections.  Clicking on a form link in any section will bring up that form for the user 
to fill in. 
 

 
 

Form Options 
There are additional tools in the purple banner on the right side of the screen. 
 

 
 
Legend 
New Note – allows the user to create a new note for other users.  
NOTE: For more information, please see the Notes section in the Tools area. 

 
Save – allows the user to save the form. 
Add (not shown)– allows the user to create an additional instance of the form.   It is the digital equivalent to being 
handed an extra piece of paper of a specific form to staple to an existing packet of forms. 

 
Delete (not shown) – allows the user to delete the instance of the form that is visible to the user.  Clicking DELETE clears 
out the fields on the form (including any uploaded attachments). 
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Tools 
The Tools section contains a list of customized tools available to the user depending on the role assigned to the user.   
 

 
 
 
Legend Summary 
Landing Page – the default application page. 
Add/Edit People – allows the user to add/edit people associated with a specific document. 
Attachment Repository – allows the user to access a list of stored attachments. 
Modification Summary – allows the user to access a summary of modifications for a specific document. 
Status History – allows the user to access a history of the status(s) of a specific document. 
Notes – allows the user to create/view/edit notes for a specific document. 
Print Document – allows the user to create a PDF of the document. 
 

Landing Page  
Clicking on this link returns the user to the Document Landing Page. 
 

Document Add/Edit People 
This tool allows authorized users to add/edit people assigned to the document. 
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Adding/Assigning People to the Document 
NOTE: Not all roles can add individuals to specific documents. 
 
To add/assign a person to the specific document, please follow these instructions: 

1) Click on the Plus Sign button on the People Assigned to this Document row. 
2) Include information in the Name, Role, and/or Organization Name field(s) and click SEARCH. 

 

 
 

3)  For adding the specific user(s) to a document, select a Document Role option and click the SAVE button.  
NOTE: This will automatically assign today’s date.  Please use the calendar tool in the Active Date field to 
select a different date. 
 

 
 
Editing People Assigned to the Document 
To edit the role of a user assigned to the specific document, please follow these instructions: 

1) Click on the Pen button on the right side. 
2) Make any updates and click the SAVE button. 
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Attachment Repository 
This tool allows the user to view files that have been added as attachments throughout the document. 
 

Document Modification Summary 
This tool allows the user to view and/or download the modification summary. 
 

Status History 
This tool allows the user to view the status of the document – including the Status name, Date/Time the document had 
that status, and the name of the Person who changed the status of that document.  There is also a field for status notes. 
 

Notes 
This tool allows the user to add/edit notes. 
 

 
 
Adding a New Note 
Please use these instructions to create a note. 
 

1) Click on the NEW NOTE button and fill in the field. 
2) Click on the Paperclip icon to add a note (optional). 
3) Click on the Paper Airplane icon to SAVE the note. 

 
  



KOHS - IGX – Administration & Registration Manual 
 

1/28/21 Copyright © Agate Software, Inc.  Page 22 of 28 

 

Additional Fields 
Icon Name Description 

 

 
 

Internal Note 
This tool locks this note into the form as an internal note.  The internal notes are only 
visible to members within the same organization. 

 

 
 

Attachment(s) This tool allows the user to add attachments to the note. 

 

 
 

Editor This tool allows the user to edit a note. 

 

 
 

Save Note This tool allows the user to save the note. 

 
Locating a Note 
Once a note is created, it ends up in the Notes area of the Tools menu.   
To access the note, please follow these instructions: 
 

1) Click in the Forms section to minimize that section. 
2) Click on the Notes link in the Tools section. 

 

 
 

Updating a Note 
1) Click in the Forms section to minimize that section. 
2) Click on the Notes link in the Tools section. 
3) Click on the … icon.  This brings up the Edit, Delete and External/Internal tool buttons. 
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4) Click on the Edit tool to edit the text field. 
 

 
 

5) Click in the text field to adjust the formatting and/or the contents of the note. 
6) Click the paper airplane icon to save the updates to the note. 

 
Deleting a Note 

1) Click in the Forms section to minimize that section. 
2) Click on the Notes link in the Tools section. 
3) Click on the … icon.  This brings up the Edit, Delete and External/Internal tool buttons. 

 

 
 

4) Click on the DELETE button to delete the note. 
 
Replying to a Note 

1) Click in the Forms section to minimize that section. 
2) Click on the Notes link in the Tools section. 
3) Add a response to the Reply section and click on the airplane icon. 
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Print Document 
This tool allows the user to create a PDF version of the document to save onto the user’s computer and/or print out. 
Each form has the option of being included in the printout (with both questions and answers), excluded in the printout, 
or including a blank version of that form. 
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Status Options 
The Status Change area allows the user to change the status of a document.  This is normally useful for submitting 
applications, signing contracts, or requesting grant modifications. 
 

 
 

Related Documents 
The Related Documents section is where the user can access documents (such as reports) that are related to the 
application/contract. 
 

Accessing a Related Document 
To access a report, please follow these instructions: 

1) Navigate to the grant. 
2) Close the Forms, Tools, and Status Options sections. 
3) Click on the link in the Related Documents section. 
4) Click on the link in the 2nd column.  This will bring up the Document Landing Page for the report. 

 

 
 

Starting a Related Document 
Click on the Initiate Related Doc button (either in the Related Documents section or in the My Tasks area of the 
Dashboard). 
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Searches 
 
The Searches tab is used to quickly locate specific documents.  Different types of searches have their own search 
sections set up.  The sections below explain how to use these search sections. 
 

Grant Applications 
To use this search tab, please follow these instructions: 

1) Go to Searches → Grant Applications. 
2) OPTIONAL: Enter in search parameters.  Click the CLEAR button to clear out search parameters. 
3) Click the SEARCH button. 
4) Click on the name of a specific document in the Name column. 

 

 
 
Legend 
Name – A text field for the name of the document. 
Organization – A text field for the name of the organization that created the document. 
Type – A drop-down list to select the type of document from. 
Status – A drop-down list to select a specific document status from. 
Sub Code – A text field to enter the sub code of the document in. 
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Reimbursement Claims 
To use this search tab, please follow these instructions: 

1) Go to Searches → Reimbursement Claims. 
2) OPTIONAL: Enter in search parameters.  Click the CLEAR button to clear out search parameters. 
3) Click the SEARCH button. 
4) Click on the name of a specific document in the Name column. 

 

 
 
Legend 
Name – A text field for the name of the document. 
Organization – A text field for the name of the organization that created the document. 
Type – A drop-down list to select the type of document from. 
Status – A drop-down list to select a specific document status from. 
Sub Code – A text field to enter the sub code of the document in. 
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Assistance Requests 
To use this search tab, please follow these instructions: 

1) Go to Searches → Assistance Requests. 
2) OPTIONAL: Enter in search parameters.  Click the CLEAR button to clear out search parameters. 
3) Click the SEARCH button. 
4) Click on the name of a specific document in the Name column. 

 


